Tutorial:

Model-Based Design Using Model Composer

UG1259 (v2017.4) December 20, 2017
Revision History

The following table shows the revision history for this document.

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
</table>
# Table of Contents

Revision History .......................................................................................................................................................................... 2  
Model Composer Lab Overview ............................................................................................................................................... 4  
Introduction .................................................................................................................................................................................. 4  
Software Requirements ............................................................................................................................................................ 5  
Launching Model Composer ................................................................................................................................................. 5  
Locating and Preparing the Tutorial Files ......................................................................................................................... 6  
Lab 1: Introduction to Model Composer .............................................................................................................................. 7  
Introduction .................................................................................................................................................................................. 7  
Step 1: Review the Model Composer Library .................................................................................................................. 8  
Step 2: Build Designs with Model Composer Blocks .................................................................................................... 9  
Step 3: Work with Data Types ............................................................................................................................................ 11  
Conclusion ................................................................................................................................................................................. 18  
Lab 2: Importing Code into Model Composer ................................................................................................................. 19  
Introduction ............................................................................................................................................................................... 19  
Step 1: Set up the Example .................................................................................................................................................. 19  
Conclusion ................................................................................................................................................................................. 21  
Lab 3: Automatic Code Generation ...................................................................................................................................... 23  
Introduction ............................................................................................................................................................................... 23  
Step 1: Review Requirements for Generating Code ................................................................................................... 23  
Step 2: Mapping Interfaces ................................................................................................................................................. 25  
Step 3: Generate IP from Model Composer Design ................................................................................................... 28  
Step 4: Generate HLS Synthesizable Code .................................................................................................................... 32  
Step 5: Port a Model Composer Design to System Generator ................................................................................... 35  
Conclusion ................................................................................................................................................................................. 39  
Legal Notices ................................................................................................................................................................................. 40  
Please Read: Important Legal Notices ............................................................................................................................ 40
Model Composer Lab Overview

Introduction

Xilinx Model Composer is a model-based design tool that enables rapid design exploration within the Simulink environment and accelerates the path to production on Xilinx All Programmable devices through automatic code generation.

Model Composer is designed as an add-on to Simulink and provides a library of performance-optimized blocks for design and implementation of algorithms on Xilinx FPGAs. The Model Composer library offers over 80 predefined blocks, including application-specific blocks for Computer Vision and Image Processing and functional blocks for Math, Linear Algebra, Logic, and Bit-wise operations, among others.

You can focus on expressing algorithms using blocks from the Xilinx Model Composer library as well as custom user-imported blocks, without worrying about implementation specifics, and leverage all the capabilities of Simulink’s graphical environment for algorithm design, simulation, and functional verification. Model Composer then transforms your algorithmic specifications to production-quality implementation through automatic optimizations that extend the Xilinx High Level Synthesis technology.

This tutorial introduces the end-to-end workflow for using Model Composer.

The included labs are as follows:

- Lab 1: Introduction to Model Composer
  - Introduction to Model Composer Library Blocks for design
  - Integration with native Simulink and Support for vectors and matrices
  - Working with data types
- Lab 2: Create Custom Blocks in Model Composer
- Lab 3: Automatic Code Generation
  - Requirements for Code Generation
  - Mapping Interfaces
  - Generate an IP for use in the Vivado IP Integrator
  - Generate Vivado® HLS Synthesizable Code
  - Port a Model Composer Synthesized Design into System Generator for DSP
Software Requirements

The lab exercises in this tutorial require that you have installed the following software:

- MATLAB™: R2017b, R2017a, R2016b, or R2016a
- Vivado Design Suite release: 2017.4 (Includes Vivado HLS)
- Model Composer: 2017.4

See the Vivado Design Suite User Guide: Release Notes, Installation, and Licensing (UG973) for a complete list and description of the system and software requirements.

Launching Model Composer

To launch Model Composer:

- On Windows systems:
  - Select Start > All Programs > Xilinx Design Tools > Model Composer 2017.4 > Model Composer 2017.4.
  - OR
  - Double-click the Model Composer icon which was placed on your desktop after installation.

- On Linux systems:
  
  You launch Model Composer under Linux using a shell script called model_composer located in the <Model_composer_install_dir>/2017.4/bin directory. Before launching this script, you must make sure the MATLAB executable can be found in your Linux system’s $PATH environment variable for your Linux system. When you execute the model_composer script, it will launch the first MATLAB executable found in $PATH and attach Model Composer to that session of MATLAB. Also, the model_composer shell script supports all the options that MATLAB supports and all options can be passed as command line arguments to the model_composer script.

When Model Composer opens, you can confirm the version of MATLAB to which Model Composer is attached by entering the version command in the MATLAB Command Window.

```matlab
>> version
ans =
    '9.2.0.538062 (R2017a)'
```
Locating and Preparing the Tutorial Files

There are separate project files and sources for each of the labs in this tutorial. You can find the design files for this tutorial on the www.xilinx.com website.

1. **Download** the Reference Design Files from the Xilinx website.

2. **Extract** the zip file contents into any write-accessible location on your hard drive or network location.

   **RECOMMENDED:** You will modify the tutorial design data while working through this tutorial. You should use a new copy of the ModelComposer_Tutorial directory extracted from ug1259-model-composer-tutorial.zip each time you start this tutorial.

   **TIP:** This document assumes the tutorial files are stored at C:\ModelComposer_Tutorial. All pathnames and figures in this document refer to this pathname. If you choose to store the tutorial in another location, adjust the pathnames accordingly.

   **TIP:** Make sure to save the tutorial files in a folder structure with no spaces in them. There is a known limitation that does not support spaces in the directory structure for code generation.
Lab 1: Introduction to Model Composer

Introduction
This tutorial shows how you can use Model Composer for rapid algorithm design and simulation in the Simulink® environment.

Procedure
This lab has the following steps:

- In Step 1, you examine the Model Composer Simulink library.
- In Step 2, you build a simple design using Model Composer blocks to see how Model Composer blocks integrate with native Simulink blocks and supported Signal Dimensions.
- In Step 3, you look at data types supported by Model Composer and the conversion between data types.
Step 1: Review the Model Composer Library

In this section you see how Model Composer fits into the Simulink environment, and then review the categories of blocks available in the Model Composer library.

**Access Model Composer Library**

Model Composer provides 80+ blocks for use within the Simulink environment that you can access them from within the Simulink Library Browser:

1. Use any of these techniques to open the Simulink Library Browser:
   a. On the Home tab, click **Simulink**, and choose a model template. In the new model, click the **Library Browser** button.
   b. At the command prompt, type:
      ```
      slLibraryBrowser
      ```
2. In the browser, navigate to the **Xilinx Model Composer** library.

![Figure 1: Xilinx Model Composer Library](image)
Lab 1: Introduction to Model Composer

The Model Composer blocks are organized into subcategories based on functionality. Spend a few minutes navigating through the sub-libraries and familiarizing yourself with the available blocks.

---

### Step 2: Build Designs with Model Composer Blocks

In this step, you build a simple design using the existing Model Composer blocks.

**Sobel Edge Detection: Algorithm Overview**

Sobel edge detection is a classical algorithm in the field of image and video processing for the extraction of object edges. Edge detection using Sobel operators works on the premise of computing an estimate of the first derivative of an image to extract edge information.

![Sobel Edge Detection](image)

**Implementing Algorithm in Model Composer**

1. **In the MATLAB Current Folder, navigate to** `ModelComposer_Tutorial\Lab1\Section1`.

2. **Double-click the Sobel_EdgeDetection_start.slx model.**

   This model already contains source and sink blocks (from Simulink’s **Computer Vision System Toolbox**), to stream video files as input directly into your algorithm and view the results. The model also contains some of the needed Model Composer blocks required for this section. Note the difference in appearance for the Model Composer blocks in the design versus the Simulink blocks.

3. **From the Library Browser, select the Sobel Filter block from the Computer Vision sub-library of the Xilinx Model Composer library. Drag the block into the area labeled Convolve Image Frame with Sobel Kernel and Compute Gradient as shown in Figure 4 and connect the input of this block to the output of the From Multimedia File block.**

   **Note:** You can also add Model Composer blocks directly into your model by typing the block name onto the canvas (same as Simulink blocks).

![Searching for Sobel Filter Block](image)
4. From the Library Browser, select the **Gradient Magnitude** block from the Xilinx Model Composer library (also found in the **Computer Vision** sub-library), drag it into the model, and connect the X and Y outputs of the **Sobel Filter** block to the input of this block.

5. Connect the rest of the blocks to complete the algorithm as shown in the following figure:

![Figure 4: Algorithm with Sobel Filter and Gradient Magnitude](image)

6. Select the **Simulation > Run** command or click the ![button](image) button to simulate the model and view the results of the Sobel Edge Detection algorithm.

   **Note:** The Model Composer blocks can operate on matrices (image frames in the following figure).

![Figure 5: Input and Output Videos](image)

One way to assess the simulation performance of the algorithm is to check the video frame rate of the simulation. To do this:

7. Add the **Frame Rate Display** block from the Simulink **Computer Vision System Toolbox** (under the **Sinks** category) and connect it to the output of the algorithm as shown in Figure 6.

8. Simulate the model again to see the number of video frames processed per second.
9. Try these things:
   
   - Change the input video through the From Multimedia File block by double-clicking the block and changing the File Name field to select a different video. Notice that changing the video resolution in the Source block does not require any structural modifications to the algorithm itself.  
     
     **Note:** You must stop simulation before you can change the input file. Also, the .mp4 files in the directory are not supported.

   - Build any variations using other available blocks in the Computer Vision sub-library in Model Composer.
     
     **Note:** You can find other smaller examples for reference in the folder ModelComposer_Tutorial\Lab1\Section1\Examples

---

**Step 3: Work with Data Types**

In this section, you become familiar with the supported Data Types for Model Composer and conversion from floating to fixed-point types.

This exercise has two primary parts, and one optional part:

- Review a simple floating-point algorithm using Model Composer.
- Look at Data Type Conversions in Model Composer designs.

**Work with Native Simulink Data Types**

1. In the MATLAB Current Folder, navigate to the ModelComposer_Tutorial\Lab1\Section2 folder.

---
2. Double-click ColorSpace_Conversion.slx to open the design.
   This is a Color Space conversion design, built with basic Model Composer blocks, that performs a RGB to YCbCr conversion.

3. Update the model (Ctrl+D) and observe that the Data Types, Signal Dimensions and Sample Times from the Source blocks in Simulink all propagate through the Model Composer blocks. Note that the design uses single precision floating point data types.

4. Simulate the model and observe the results from simulation.

Convert Data Types

To convert the previous design to use Xilinx Fixed Point types:

1. Double-click ColorSpace_Conversion_fixed_start.slx in the Current Folder to open the design.

2. Open the Xilinx Model Composer library in the Simulink Library Browser.

3. Navigate to the Signal Attributes sub-library, select the Data Type Conversion block, and drag it into the empty slots in the designs, before and after the RGB to YCbCr subsystem.

   ![Figure 7: Model Composer Data Type Conversion Block](image_url)
4. Open the **Data Type Conversion** blocks at the inputs of the **RGB to YCbCr** Subsystem, and do the following:
   - Change the **Output data type** parameter to **fixed**.
   - Set the **Signedness** to **Unsigned**.
   - Set the **Word length** to **8**.
   - Set the **Fractional length** to **7**.
   - Click **Apply**, and close the dialog box.
5. On the **Data Type Conversion** blocks at the output of the **RGB to YCbCr** Subsystem, set the **Output data type** parameter to **single**. This will enable connecting the output signals to the Video Viewer blocks for visualization.

6. Double-click the **RGB to YCbCr** subsystem to descend the hierarchy and open the model. Within the **RGB to YCbCr** subsystem, there are subsystems to calculate Y, Cb, and Cr components using Gain and Constant blocks.
You can control the fixed point types for the gain parameter in the **Gain** blocks and the value in the **Constant** blocks. You can do this by opening up the **Calculate_Y**, **Calculate_Cb**, and **Calculate_Cr** blocks and setting the data types as follows.

For **Gain** blocks, set the **Gain data type** to **fixed** and the following options appear:
- Signedness to **Signed**
- Gain data type to **fixed**
- Word length to 8
- Fractional length to 7

For **Constant** blocks, on the **Data Types** tab set the **Output data type** to **fixed** and the following options appear:
- Signedness to **Signed**
- Output data type to **fixed**
- Word Length to 8
- Fractional Length to 7

**TIP:** You can use the **View > Property Inspector** command to open the Property Inspector window. When you select the different Gain or Constant blocks, you can see and modify the properties on the selected block.

Make sure you do this for all the Constant and Gain blocks in the design. Update the model (**Ctrl+D**) and observe the fixed point data types being propagated in the design as shown below.

![Figure 11: Propagated Xilinx Fixed-Point Data Types](image)
\( x_{[u/s]fix[wl]}_{En[fl]} \)

- **u**: Unsigned
- **s**: Signed
- **wl**: Word Length
- **fl**: Fractional Length

For example, \( x_{sfix16\_En8} \) represents a signed fixed point number with Word Length=16 and Fractional Length=8.

You can view a completed version of the design here:

ModelComposer_Tutorial\Lab1\Section2\solution\Colorscape_Conversion_fixed\.slx

### Convert Data Types (Alternative)

Model Composer supports Data Type Expressions that make it easier to change data types and quickly explore the results from your design.

1. Double-click ColorSpace_Conversion_Expression.slx in the Current Folder to open the design.

2. Notice that the **Data Type Conversion** blocks at the Input of the **RGB to YCbCr** Subsystem, the **Gain** blocks and **Constant** blocks within the Subsystem have corresponding **Output data type** and **Gain data type** set to **data type expression**.

![Figure 12: Controlling Data Types with Workspace Variables](image)

This enables Model Composer blocks to control the data types in the design using workspace variables, in this case **InputDataType** and **FDataType** that you can easily change from the MATLAB command prompt.
3. Update the model (Ctrl+D) and observe the fixed-point data types propagated through the blocks. The other Model Composer blocks in the design will automatically take care of the bit-growth in the design. If you want more control over the fixed point data types at other intermediate portions of the design, you can insert Data Type Conversion blocks wherever necessary.

4. To change the fixed point types in the Gain and Constant blocks, type the following at the MATLAB command prompt:

   ```
   >> FDataType = 'x_sfix8_En6'
   >> InputDataType = 'x_ufix8_En6'
   ```

   'x_sfix8_En6' represents a signed fixed point number with Word Length 8 and Fractional Length 6. Now update the model (Ctrl+D) and observe how the fixed-point data types have changed in the design.

5. Simulate the model and observe the results from the design. Try further changing “InputDataType” and “FDataType” variables through command line and iterate through multiple word lengths and fractional lengths. See the Additional Details section below for information on specifying rounding and overflow modes as well.

**Additional Details:**

In the example above, we only specified the Word Length and Fractional Length of the fixed point data types using data type expressions. However, for greater control over the fixed point types in your design, you can also specify the Signedness, Rounding, and Overflow. In general the format used for specifying fixed point data types using the data type expression is

```
x_{[u/s]fix[wl]}_En[fl]_[r<round>w<overflow>]
```

- **u:** Unsigned
- **s:** Signed
- **wl:** word length
- **fl:** Fractional length
- **<round>:** Specify the corresponding index from table below. It’s optional. If not specified, default value is 6 (Truncation to minus infinity). Note that for the rounding cases (1 to 5), the data is rounded to the nearest value that can be represented in the format. When there is a need for tie breaker, these particular roundings behave as specified in the **Meaning** column.

<table>
<thead>
<tr>
<th>Index</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Round to Plus Infinity</td>
</tr>
<tr>
<td>2</td>
<td>Round to Zero</td>
</tr>
<tr>
<td>3</td>
<td>Round to Minus Infinity</td>
</tr>
<tr>
<td>4</td>
<td>Round to Infinity</td>
</tr>
</tbody>
</table>
5 Convergent Rounding
6 Truncation to Minus Infinity
7 Truncation to Zero

<overflow>: Specify the corresponding index from table below. It’s optional. If not specified, default value is 4 (Wrap around)

<table>
<thead>
<tr>
<th>Index</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Saturation</td>
</tr>
<tr>
<td>2</td>
<td>Saturation to Zero</td>
</tr>
<tr>
<td>3</td>
<td>Symmetrical Saturation</td>
</tr>
<tr>
<td>4</td>
<td>Wrap Around</td>
</tr>
<tr>
<td>5</td>
<td>Sign-Magnitude Wrap Around</td>
</tr>
</tbody>
</table>

Example. `x_ufix8_En6_r6w4` represents a fixed point data type with

Signedness: Unsigned

Word Length: 8

Fractional Length: 6

Rounding Mode: Truncation to Minus Infinity

Overflow Mode: Wrap Around

Conclusion

In this lab, you learned:

- How to connect Model Composer blocks directly to native Simulink blocks.
- How the Model Composer blocks support Vectors and Matrices, allowing you to process an entire frame of an image at a time and not have to convert from a frame to a stream of pixels at the input.
- How to work with different data types.
- How to use the Data Type Conversion block to control the conversion between data types, including floating-point to fixed-point data types.

Note: Model Composer supports the same floating and integer data types as Simulink blocks. Model Composer also supports Xilinx fixed point data types.

The following solution directories contain the final Model Composer files for this lab:

C:\ModelComposer_Tutorial\Lab1\Section1\solution
C:\ModelComposer_Tutorial\Lab1\Section2\solution
Lab 2: Importing Code into Model Composer

Introduction

Model Composer lets you import Vivado HLS library functions and user C/C++ code as custom blocks to use in your algorithm for both simulation and code generation.

The Library Import feature is a MATLAB function, `xmcCreateLibrary`, which lets you specify the required source files and automatically creates an associated block that can be added into a model in Simulink.

In this lab you are introduced to the `xmcCreateLibrary` function, and walk through an example.

Step 1: Set up the Example

1. In the MATLAB Current Folder, navigate to the `ModelComposer_Tutorial\Lab2` folder.
2. Double-click the `basic_array.cpp` and `basic_array.h` files to view the source code in the MATLAB Editor.

   These are the source files for a simple `basic_array` function in C++, which calculates the sum of two arrays of size 4. You will import this function as a Model Composer block using the `xmcCreateLibrary` function.

   The input and output ports for the generated block are determined by the signature of the source function. Model Composer identifies arguments specified with the `const` qualifier as inputs to the block, and all other arguments as outputs.

   **IMPORTANT: You must use the `const` qualifier in the function signature to identify the inputs to the block.**

   In the case of the `basic_array` function, the `in1` and `in2` arguments are identified as inputs.

     ```c
     void basic_array(
       uint8_t out1[4],
       const uint8_t in1[4],
       const uint8_t in2[4])
     {  
     }
     ```

3. To learn how to use the `xmcCreateLibrary` function, type `help xmcCreateLibrary` at the MATLAB command prompt to view the help text and understand the function signature.
4. Open the `create_library.m` MATLAB script, and fill in the required fields for the `xmcCreateLibrary` function in this way:
The information is defined as follows:

- **Library Name**: basic_array_library. This is the name of the Simulink library that is created with the new block.
- **Function Names**: basic_array. This is the name of the function that you want to import as a block.
- **Header File**: basic_array.h. This is the header file for the function.
- **Source Files**: basic_array.cpp. This is the source file for the imported function.
- **Search Paths**: This argument is used to specify the search path(s) for header files. In this example, there are no additional search paths to specify and hence you can leave it as `{ }` which indicates none.

*Note: Look at create_library_solution.m in the solution folder for the completed version.*

5. Run the `create_library.m` script from the MATLAB command line:
   ```
   >> run('create_library.m')
   ```
   Notice that a Simulink library model opens up with the generated block `basic_array`.
   Save this Simulink library model.

6. Double-click the `basic_array` block, and look at the generated interface.
   The following figure shows the Block Parameters dialog box for `basic_array`:
7. Open the test_array.slx model, which is just a skeleton to test the generated block.
8. Add the generated basic_array block into this model, then connect the source and sink blocks.
9. Simulate this model and observe the results in the display block.

**Conclusion**

In this lab, you learned:

- How to create a custom block in Model Composer.
- How to import a function in C++ as a Model Composer block using the library function.

*Note: Current feature support enables you to import code that uses:*

- Vectors and 2D matrices
- Floating, integer, and Vivado HLS fixed-point data types
Lab 2: Importing Code into Model Composer

- Templates that allow variable size Inputs. If you are interested, look at the example saved under ModelComposer_Tutorial\Lab2\Template_Example and follow the instructions in the README.txt file.

The following solution directory contains the final Model Composer (*.slx) files for this lab.

C:\ModelComposer_Tutorial\Lab2\solution
Lab 3: Automatic Code Generation

Introduction

In this lab, you look at the flow for generating output from your Model Composer model and moving it into downstream tools like Vivado HLS for RTL synthesis, or into System Generator, or the Vivado Design Suite for implementation into a Xilinx device.

Procedure

This lab has five steps:

In Step 1, you review the requirements for automatic code generation.

In Step 2, you look at how to map Interfaces in your design.

In Step 3, you look at the flow for generating an IP from your Model Composer design.

In Step 4, you look at the flow for generating HLS Synthesizable C++ code from the Model Composer design.

In Step 5, you look at the flow to port a Model Composer design back into System Generator for DSP as a block.

Step 1: Review Requirements for Generating Code

In this step, you review the three requirements to move from your algorithm in Simulink to an implementation through automatic code generation.

1. In the MATLAB Current Folder, navigate to the ModelComposer_Tutorial\Lab3 directory.
2. Double-click CodeGen_start.slx to open the model.

To prepare for code generation, you will enclose your Model Composer design in a subsystem.

3. Right-click the Edge Detection area, and select Create Subsystem from Area.

   Note: For code generation to work, all the blocks within the enclosed subsystem should be from the Xilinx Model Composer library in the Simulink Library Browser (except for the Simulink blocks noted below). If not, the code generation process will error out with links to the unsupported blocks in the design.

   Note: In addition to the base Model Composer blocks, a subset of native Simulink blocks such as From, Goto, Bus Creator, Bus Selector, If, and others, are supported. The supported Simulink blocks appear within the Xilinx Model Composer libraries as well.
Next, you **add the Model Composer Hub block at the top level of your design.**

4. Open the Simulink Library Browser and navigate to **Xilinx Model Composer Tools** sub-library.
5. Find the **Model Composer Hub** block, and add it into the design as shown in the following figure:

![Figure 14: Edge Detection with Model Composer Hub Block](image)

Next, you use the **Model Composer Hub** block to **select the code generation options for the design.**

6. Double-click the block to open the block interface and set up as shown in the following figure:

![Figure 15: Block Parameters Dialog Box](image)
7. On the Compilation tab, you can select the following:
   - **Target Directory**: Location for the generated code
   - **Subsystem name**: In this case, the **Edge Detection** subsystem. You can have multiple subsystems at the top-level and use the **Model Composer Hub** block to select and individually compile the subsystem you want.
   - **Export Type**: This option determines what you want to convert your design into.
     1. IP Catalog (default)
     2. Vivado HLS Synthesizable C++ code
     3. System Generator for DSP

8. On the Clocking tab, you can specify the target **FPGA clock frequency** in MHz. The default value is 200MHz.

---

**Step 2: Mapping Interfaces**

1. Double-click the **CodeGen_Interface.slx** model in your Current Folder to open the design for this lab section.
   - This is a slightly modified version of the Edge Detection algorithm that uses the YCbCr video format at the input and output.
2. Simulate the model to see the results in the **Video Viewer** blocks.
3. Open the Simulink Library browser, navigate to the Xilinx **Model Composer > Tools** sub-library and add the **Interface Spec** block inside the **Edge Detection** subsystem as shown in the following figure:
4. Double-click the **Interface Spec** block to open the block interface.

The **Interface Spec** block allows you to control what RTL interfaces should be synthesized for the ports of the subsystem in which the block is instantiated. This affects only code generation; it has no effect on Simulink simulation of your design.

The information gathered by the Interface Spec block consists of three parts (represented as three Tabs on the block):

- **Function Protocol**: This is the block-level Interface Protocol which tells the IP when to start processing data. It is also used by the IP to indicate whether it accepts new data, or whether it has completed an operation, or whether it is idle.

- **Input Ports**: Detects the Input ports in your subsystem automatically and allows specifying the port-level Interface Protocol for each input port of the subsystem.
• **Output Ports:** Similar to the Input Ports tab, this tab detects the Output ports in the subsystem, and allows specifying the port-level Interface Protocol for each output port of the subsystem.

5. For this design, leave the **Function Protocol** mode at the default **AXI4-Lite** and configure the Input ports and Output ports tabs as shown in the following figures:

![Figure 18: Input Port Settings](image)

The **Bundle** parameter is used in conjunction with the AXI4-Lite or AXI4-Stream (video) interfaces to indicate that multiple ports should be grouped into the same interface. It lets you bundle multiple input/output signals with the same specified bundle name into a single interface port and assigns the corresponding name to the RTL port.

For example in this case, the specified settings on the Input ports tab result in the YCbCr inputs being mapped to AXI4-Stream (video) interfaces and bundled together as an **image_in** port in the generated IP while the YCbCr outputs are bundled together as an **image_out** port.

• The **Video Format** drop-down menu lets you select between the following formats:
  - **YUV 4:2:2**
The Video Component drop-down menu is used to subsequently select the right component: R, G, B, Y, U, V.

---

### Step 3: Generate IP from Model Composer Design

Using the same example, you will generate an IP from the Edge Detection algorithm.

1. Double-click the `CodeGen_IP.slx` model in the Current Folder.
2. Double-click the **Model Composer Hub** block, and set the following in the block dialog box:
   - **Export Type**: IP Catalog (default)
   - **Target Directory**: codegen_IP
   - **Subsystem name**: Edge Detection
3. In the `CodeGen_IP.slx` model, double-click into the **Edge Detection** subsystem and review the settings on the **Interface Spec** block. Based on the previous lab, this block has already been set up to map the input and output ports to AXI4-Stream Video interface and to use the YUV 4:2:2 video format.
4. To generate an IP from this design, click the **Apply** button in the **Model Composer Hub** block dialog box to save the settings. Then click the **Generate** button to start the code generation process.

   Model Composer opens a progress window to show you the status. After completion, click **OK** and you will see the new `codegen_IP` folder in the current folder, which contains the generated IP solution folder.
At the end of the IP generation process, Model Composer opens the **Performance Estimates** and **Utilization Estimates** (from Vivado HLS Synthesis report) in the MATLAB Editor, as shown in the following figures:

*Note: The Performance and Utilization Numbers here may vary slightly depending on software release.*
Figure 21: Performance Estimates

Figure 22: Utilization Estimates

You can also see a summary of the generated RTL ports and their associated protocols at the bottom of the report.
5. To add the generated IP to the Vivado IP catalog, *create a Vivado RTL project*. When you create the Vivado RTL project, specify the **Board** as Kintex-7 KC705 Evaluation Platform (which is the same as the default Board in the Model Composer Hub block).

6. In the **Vivado Flow Navigator**, click **IP Catalog**.

7. On the IP Catalog panel, select Vivado Repository, right-click and select **Add Repository**.

8. Select the `codegen_IP\Edge_Detection_prj\solution1\impl\ip` folder

   The generated **Edge_detection** IP now shows in the IP catalog under **Vivado HLS IP**.

You can now add this IP into an IP integrator block diagram, as shown in the following figure:
Step 4: Generate HLS Synthesizable Code

In this section you will generate HLS Synthesizable code from the original Edge Detection design. Use the CodeGen_Cplus.slx design for this lab. Simulate the model and ensure that algorithm is functionally correct and gives you the results you would expect.

1. Open the Model Composer Hub block dialog box, and set the following:
   - Export Type: C++ code
   - Target Directory: ./codegen_edge_detection
   - Subsystem name: Edge Detection

2. Click the Apply button on the Model Composer Hub block dialog box to save the settings and then click the Generate button to start the code generation process.
3. At the end of code generation, observe the Current Folder in MATLAB. You should now see a new folder: `codegen_edge_detection` in your Current Folder.

When you click Generate on the Model Composer Hub block, Model Composer first simulates the model, then generates the code and places the generated code files in the Target Directory folder. At the end of the code generation process, the window showing the progress of the code generation process tells you where to look for your generated code.

4. Open the `codegen_edge_detection` folder and explore the generated code files highlighted in the following figure:

![Figure 27: Two Files to Explore in Current Folder](image)

Note:
- `Edge_Detection.cpp` is the main file generated for the subsystem.
- `run_hls.tcl` is the Tcl file needed to create the Vivado HLS project and synthesize the design.

5. In the design, open the Model Composer Hub block dialog box, and modify the block settings, shown in the following figure, as follows:
   - Check the Create and execute testbench checkbox.
   - Modify the Target Directory folder.
6. Click **Apply** and regenerate the code by clicking the **Generate** button. Click OK after you see Done Verification in the status bar.

   You should now see a new folder, `codegen_edge_detection2`, in your current folder.

7. Open the `codegen_edge_detection2` folder and explore the generated code files.
With the **Create and execute testbench** option selected on the **Model Composer Hub** block, Model Composer logs the inputs and outputs at the boundary of the Edge Detection subsystem and saves the logged stimulus signals in the `signals.stim` file. The `tb.cpp` file is the automatically-generated test bench that you can use for verification in Vivado HLS. At the end of the code generation process, Model Composer automatically verifies that the output from the generated code matches the output logged from the simulation and reports any errors.

---

**Step 5: Port a Model Composer Design to System Generator**

Using Model Composer, you can package a model for integration into a System Generator model, which is especially useful if you are an existing System Generator for DSP user. This allows you to take advantage of both the high level of abstraction and simulation speed provided by Model Composer for portions of your design, and the more architecture-aware environment provided by System Generator.
Lab 3: Automatic Code Generation

Choosing **System Generator** as the **Export type**, and clicking **Generate**, creates a synthesized RTL block that you can directly add to a System Generator design using the Vivado HLS block in System Generator.

In this lab, you create an IP using Model Composer and then use the synthesized RTL as a block in a System Generator design.

1. **In the ModelComposer_Tutorial/Lab3/ModelComposer_to_SysGen folder**, double-click MoC_design.slx to see the Model Composer design. The design is configured to have AXI4 streaming interfaces at both the input and output. This is done through the **Interface Spec** block within the **ModelComposerDesign** subsystem. Note that there are no structural changes required at the Simulink level to change interfaces for the IP.
2. Open the followme_script.m in MATLAB. This script will guide you through all the steps to import the Model Composer generated solution as block in System Generator.

3. Read the comments at the start of each section (labeled Section 1 to Section 8) in the MATLAB script and execute each section one at a time (the start of each section is marked by a %% sign). You can click on Run and Advance to step through each section in the script. The sections are as follows:
   a. **Section 1: Set up**
      
      Open MATLAB for Model Composer and choose a video file as an input.
   
   b. **Section 2: Creating a System Generator solution from a Model Composer design.**
      
      Model Composer allows you to export a design as a block into System Generator. The result of exporting a design from Model Composer to System Generator is a solution folder that you will import into the System Generator design using Vivado HLS block in System Generator.
   
   c. **Section 3: Serializing the input video**
      
      Serialize the input video which is required for use with the System Generator design which will do pixel-based processing.
d. **Section 4: Launch System Generator**

Using System Generator currently requires launching a separate MATLAB session using the System Generator Launcher.

e. **Section 5: Import the generated solution into System Generator**

Set up the Vivado HLS block in the System Generator design to point to the correct solution folder generated in Section 2.

f. **Section 6: Simulate the System Generator Design**

Simulate the System Generator design and save the outputs into a MAT file. Note that the simulation will be slower than the Model Composer design since we are simulating the generated RTL and are doing an element-by-element based processing.

g. **Section 7: De-serializing the output of the System Generator design.**

This is a post-processing step that creates a frame-based video for playback using the outputs logged from the System Generator simulation.

h. **Section 8: Play the de-serialized output using `implay`.**

4. The AXI4 stream uses three signals, DATA, READY, and VALID. The READY signal is a back pressure signal from the slave side to the master side indicating whether the slave side can accept new data.

As you examine the System Generator model in **Section 5**, pay attention to the labels on blocks for each signal to help you understand how the model is designed. For example, whenever the IP can no longer accept input, the READY signal (top right of the Vivado HLS block) puts pressure on the master side of the input AXI FIFO by resetting the READY signal. Likewise, the input AXI FIFO pressures the input stream by resetting its READY signal.

Note that in Simulink all the inputs to a block are to one side of the block, and all the outputs are on the opposite side. As such, all the slave or master signals are not bundled together on one side of the block as you might expect.
Conclusion

In this lab, you learned:

- About the **Interface Spec** block terminology and parameter names.
- How to specify interfaces and to map them directly from the Simulink environment using the **Interface Spec** block.
- How Model Composer enables *push button IP creation* from your design in Simulink with the necessary interfaces.
- How the **Model Composer Hub** block in Model Composer helps move from algorithm to implementation.
- How to generate code files from the **Model Composer Hub** block and read them.
- How to set compilation targets to **C++ code**, **IP Catalog** and **System Generator**.

Some additional notes about Model Composer:

- Model Composer takes care of mapping interfaces as part of the code generation process and you don’t have to take care of interleaving and de-interleaving color channels and interface connections at the design level.
- An **Interface Spec** block must be placed within the subsystem for which you intend to generate code.
- For the **C++ code** compilation target, Model Composer generates everything you would need to further optimize and synthesize the design using Vivado HLS.
- Model Composer automatically generates the test vectors and test benches for C/RTL cosimulation in Vivado HLS.
- Model Composer provides an option to export a design back into System Generator through the Vivado HLS block.
- When moving from a Model Composer design to System Generator, you move from an untimed C-based bit-true design to an RTL-based bit-true and cycle-accurate design.

The following solution directory contains the final Model Composer (*.slx) files for this lab.

C:\ModelComposer_Tutorial\Lab3\solution
Legal Notices

Please Read: Important Legal Notices

The information disclosed to you hereunder (the "Materials") is provided solely for the selection and use of Xilinx products. To the maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and conditions of Xilinx’s limited warranty, please refer to Xilinx’s Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical applications, please refer to Xilinx’s Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION”) UNLESS THERE IS A SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT LIABILITY.

© Copyright 2017 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Zynq, UltraScale, and other designated brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.